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PRIMENA QGIS SOFTVERA ZA OBRADU PODATAKA O 
PUTNO-PRUŽNIM PRELAZIMA

APPLICATION OF QGIS DATA PROCESSING SOFTWARE ON 
RAILWAY CROSSINGS

The paper focuses on the analysis of the possibility of applying QGIS software for processing data on road-railway 
crossings on the example of railways in Serbia, which represent key points of interaction between road and rail traffic 
with a significant risk of accidents. Databases on extraordinary events are maintained through Excel tables of road 
crossings on railways in Serbia and tables of recorded accidents and incidents. The QGIS system is presented through 
introductory considerations and history, and then the latest version is presented with the possibilities of application in 
general and in railway traffic in particular. Data processing using the QGIS system is shown through the ways of creating 
a new project in QGIS and the graphical user interface of QGIS. The processes of creating a layer and inserting a map, 
creating a layer and inserting tracks and road-railway crossings, entering geographic points via coordinates and via 
code are given. A significant place is occupied by data visualization and analysis, as well as the ability to display data 
via HTML map tips in QGIS. The implementation of the QGIS software in the work included the display of road-railway 
crossings and the analysis of the highest concentrations of them in the entire territory of Serbia. By using the database 
on road-railway crossings and accidents over a period of five years, the zone with the largest number of crossings, the 
safety aspects of the busiest railways, and a spatial analysis of the entire railway network were identified.

Ključne reči: QGIS, železnica, putno-pružni prelazi, nesreće, baze podataka

REZIME:

Rad se fokusira na analizu mogućnosti primene QGIS softvera za obradu podataka o putno-pružnim prelazima (PPP) 
na primeru pruga u Srbiji, koji predstavljaju ključne tačke interakcije između drumskog i železničkog saobraćaja sa 
značajnim rizikom od nesreća. Baze podataka o vanrednim događajima vode se preko eksel tabela putnih prelaza 
na prugama u Srbiji i tabela evidentiranih nesreća i nezgoda. QGIS sistem je predstavljen preko uvodnih razmatranja 
i istorijata, a zatim je predstavljena najnovija verzija sa mogućnostima primene uopšte i posebno u železničkom 
saobraćaju. Obrada podataka korišćenjem QGIS sistema prikazana je kroz načine kreiranja novog projekta u QGIS-u i 
grafički korisnički interfejs QGIS-a. Dati su procesi kreiranja Sloja (Layer) i ubacivanja Mape, kreiranja sloja i ubacivanja 
pruga i PPP, unosa geografskih tačaka putem koordinata i putem koda. Značajno mesto zauzima vizualizacija i analiza 
podataka, kao i mogućnost prikaza podataka putem HTML map tips -a u QGIS-u. Implementacija QGIS softvera u radu 
obuhvatila je prikaz PPP i analizu koncentracije u Srbiji. Korišćenjem baze podataka o PPP i nesrećama u periodu od 
pet godina identifikovane su zona sa najvećim brojem PPP, bezbednosni aspekati najopterećenijih pruga i izvršena je 
prostorna analiza cele železničke mreže.
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1. UVOD

Rad se bavi analizom putno-pružnih prelaza (PPP), 
koji predstavljaju ključne tačke interakcije između 
drumskog i železničkog saobraćaja. Ove tačke su od 
izuzetnog značaja za bezbednost i efikasnost sao-
braćaja, jer predstavljaju kritična mesta interakcije 
dve različite vrste saobraćaja. To su mesta na kojima 
je najveći rizik od nesreća. Analiza i unapređenje bez-
bednosti na ovim prelazima može značajno dopri-
neti smanjenju broja nesreća i unapređenju ukupne 
saobraćajne infrastrukture. Cilj rada je da se prikaže 
mogućnost primene QGIS sistema kao baze podataka 
o stanju PPP na železničkoj mreži u Srbiji. Prikazan 
je način obrade podataka korišćenjem QGIS siste-
ma, tj. kroz način kreiranja novog projekta u QGIS-u 
i grafički korisnički interfejs QGIS-a. Dati su procesi 
kreiranja Sloja (Layer-a) i ubacivanja Mape, kreiranja 
sloja i ubacivanja pruga i PPP, unosa geografskih tača-
ka putem koordinata i putem koda. Značajno mesto 
zauzima vizualizacija i analiza podataka, kao i mo-
gućnost prikaza podataka putem HTML map tips -a u 
QGIS-u. Implementacija QGIS softvera u radu obuhva-
tila je prikaz PPP i analizu koncentracije u Srbiji.

Rad se bazira na detaljnoj analizi trenutnog stanja 
putno-pružnih prelaza, pregledima relevantne li- 
terature i regulativa, kao i na studijama slučajeva. 
Rad je organizovan u šest poglavlja. Nakon uvod-
nih razmatranja, u drugom poglavlju razmatraju 
se osnovni pojmovi u vezi sa puto-pružnim prela- 
zima, načinima osiguranja i načinima prijavljivan-
ja nesreća i nezgoda. U trećem poglavlju prikazana 
je baza podataka korišćena za izradu rada, kao i 
obrađeni karakteristični podaci o PPP koji su pri-
menjeni i implementirani u softveru QGIS.

U četvrtom poglavlju nalaze se osnove rada u QGIS 
softveru, mogućnosti rada samog softvera, kao i 
mogućnosti njegove implementacije u železnici, 
dok je u petom poglavlju prikazana obrada poda-
taka, primena softvera kao i vizuelni prikaz poda-
taka o PPP putem HTML-a. Na kraju su izložena 
zaključna razmatranja.

2. PUTNO-PRUŽNI PRELAZI 

Putno-pružni prelazi, denivelacija, signalizacija, 

održavanje infrastrukture, edukacija učesnika u 
saobraćaju i tehnološka rešenja ključni su fakto-
ri koji obezbeđuju bezbedno i efikasno obavljan-
je drumskog i železničkog saobraćaja. Ove mere 
smanjuju rizik od nesreća i obezbeđuju zaštitu 
učesnika u saobraćaju, osiguravaju funkcionalnost 
infrastrukture i bezbednost učesnika u saobraćaju 
na svim nivoima.

Putno-pružni prelaz [1] je mesto ukrštanja 
železničke pruge, koja pripada javnoj železničkoj 
infrastrukturi, industrijskoj železnici ili industrijs-
kom kolo- seku i puta u istom nivou, koji obuhvata 
i ukrštanje tih koloseka sa pešačkom ili biciklistič-
kom stazom, u širini od 3 m mereno od ose kolo- 
seka, uključujući i prostor između koloseka kada 
se na putnom prelazu nalazi više koloseka.

Zona potrebne preglednosti je trodimenzional-
ni prostor preglednosti u kome se vrši bezbedno 
zaustavljanje drumskih vozila ispred saobraćaj- 
nog znaka koji označava mesto na kome put 
prelazi preko železničke pruge na putnom prelazu. 
Zona potrebne preglednosti mora biti obezbeđena 
učesnicima drumskog saobraćaja na svakoj tački 
puta ispred putnog prelaza, a određuje se na os-
novu vrednosti računske brzine drumskih vozila 
i najveće dopuštene brzine železničkog vozila na 
pruzi [1]. 

Mesto ukrštanja železničke pruge i puta je [1] 
mesto u naseljenom ili van naseljenog područja 
grada ili opštine, na mestu gde se presecaju osa 
koloseka železničke pruge i osa kolovoza puta, u 
nivou koloseka (putni prelaz) ili van nivoa kolose-
ka (denivelisanim putnim objektom), a koje je kao 
takvo planirano urbanističkim ili prostornim pla-
nom lokalne samouprave (grada ili opštine). 

Signalno-sigurnosni uređaj na putno-pružnom 
prelazu je uređaj železničke infrastrukture koji 
aktivira putnu saobraćajnu signalizaciju na put-
nom prelazu, kojom se učesnicima u drums-
kom saobraćaju neposredno najavljuje nailazak 
železničkih vozila i upozoravaju da kretanje prila-
gode tako da se bezuslovno moraju zaustaviti is-
pred putnog prelaza jer neposredno predstoji 
prolazak železničkog vozila [1].
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Slika 2.Putno-pružni prelaz u nivou sa branicima

2.1. Način ukrštanja železničkog i drumskog 
saobraćaja i mere za osiguranje bezbednosti 

saobraćaja na PPP

Ukrštanje železničke pruge i puta, pešačke ili 
biciklističke staze vrši se na dva načina i to:
1.	 van nivoa koloseka, izgradnjom objek-

ta drumske denivelacije, odnosno putnog 
podvožnjaka ili nadvožnjaka, pešačkog ili 
biciklističkog pothodnika ili nadvožnjaka ili 
pešačkih pasarela;

2.	 u nivou koloseka, izgradnjom putnih prelaza, 
sa odgovarajućom opremom ili uređajima za 
obezbeđenje saobraćaja, kao i na zajedničkom 
železničko-drumskom mostu sa kolovozom 
puta u nivou koloseka i po trasi koloseka.

Mere za osiguranje bezbednog saobraćaja na put-
nim prelazima zavise od gustine saobraćaja, pre-
glednosti železničke pruge, brzine vožnje na pruzi 
i putu i od mesnih uslova u skladu sa zakonom 
kojim se uređuje bezbednost i interoperabilnost 
železnice. Saobraćaj na putnim prelazima obez-
beđuje se:
1.	 saobraćajnim znakovima na putu i zonom po-

trebne preglednosti;
2.	 svetlosnim saobraćajnim znakovima i sao-

braćajnim znakovima na putu;
3.	 automatskim polubranicima sa svetlosnim 

saobraćajnim znakovima i saobraćajnim zna-
kovima na putu;

4.	 branicima i saobraćajnim znakovima na putu;
5.	 neposrednim regulisanjem saobraćaja na put-

nom prelazu i posebnim merama;
6.	 zaštitnim ogradama i saobraćajnim znakovima 

ili mimoilaznicama i saobraćajnim znakovima 
na putnim prelazima za pešake i bicikliste.

Saobraćajni znakovi na putu ispred putno-pružnih 
prelaza su:
1.	 znak koji označava mesto na kome put prelazi 

preko železničke pruge u nivou koloseka,
2.	 znak za ograničenje brzine. 

Na PPP prelazima opremljenim signalno-sigurnos-
nim uređajima mogu se instalirati video- kamere 
za vizuelni nadzor zone putnog prelaza, železničke 
imovine, zauzetosti kolovoza i izvršenja bezbed-

nosti saobraćaja, kao i nadzor svih učesnika sao-
braćaja na putnom prelazu [1].

2.2. Obezbeđenje saobraćaja na PPP

Putno-pružni prelazi mogu i moraju biti obez-
beđeni na jedan od ova tri načina:
1.	 svetlosnim saobraćajnim znacima i saobra-  

ćajnim znacima na putu (slika 1),
2.	 automatskim polubranicima sa svetlosnim 

saobraćajnim znacima,
3.	 branicima i saobraćajnim znacima (slika 2).

Slika 1. Putno-pružni prelaz u nivou bez branika ili 
polubranika (greška)

Svetlosnim saobraćajnim znacima i saobraćajnim 
znacima na putu obezbeđuje se saobraćaj samo na 
mestu ukrštanja jednokolosečne železničke pruge 
i puta. Svetlosni saobraćajni znak, kada je aktivi-
ran, prema putu pokazuje crveno trepćuće svetlo 
usmereno tako da je jasno vidljivo sa puta. Isprav-
nost svetlosnih saobraćajnih znakova na putnom 
prelazu kontroliše se u posednutom železničkom 
službenom mestu ili kontrolnim pružnim signali-
ma na železničkoj pruzi. Svetlosnim saobraćajnim 
znacima mogu se dodati zvučni signali, u skladu 
sa propisima kojima se uređuje saobraćajna sig-

Primena QGIS softvera za obradu podataka o putno-pružnim prelazima



Ž E L E Z N I C E

105
DECEMBAR 2024

Primena QGIS softvera za obradu podataka o putno-pružnim prelazima

nalizacija na putevima i tehnički uslovi za signal-
no-sigurnosne uređaje, radi podsticanja pažnje i 
opreznosti kod učesnika u drumskom saobraća-
ju. Zvučni signal se daje neprekidno, sve vreme 
dok svetlosni saobraćajni znak pokazuje crveno 
trepćuće svetlo [1].

Automatskim polubranicima sa svetlosnim sao-
braćajnim znacima i saobraćajnim znacima na 
putu, vrši se obezbeđenje saobraćaja na putnim 
prelazima,- i to [1]:
1.	 magistralne železničke pruge sa državnim 

putevima I reda, kao i II reda sa drumskim 
saobraćajem na prelazu preko železničke 
pruge sa prosečnim protokom većim od 2.500 
drumskih vozila;

2.	 magistralne i regionalne železničke pruge i 
puta, ako je najveća dopuštena brzina na pruzi 
veća od 120 km/h i

3.	 ostalih železničkih pruga sa putevima, ako 
je na putu prosečan protok veći od 5.000 
drumskih vozila.

Branicima i saobraćajnim znacima na putu vrši se 
obezbeđenje saobraćaja na putnom prelazu u nase- 
ljenom mestu i na drugim mestima gde je to sao-
braćajno-tehnički opravdano. Branikom se drums-
ki saobraćaj zatvara preko cele širine puta kada 
se železničko vozilo približava putno-pružnom 
prelazu. Obezbeđenje saobraćaja uređajima sa 
branicima i saobraćajnim znacima na putu vrši se 
na mestima gde je to saobraćajno-tehnički opravda-
no. Drumski saobraćaj na celoj širini kolovoza puta 
ispred koloseka, sa obe strane železničke pruge, 
zatvara se branikom. Branici prema načinu pogona 
mogu da budu na električni i na mehanički pogon. 
Prema mestu upravljanja mogu da budu oni kojima 
se upravlja iz daljine i na licu mesta [1].

2.3. Prijavljivanje nesreća i nezgoda 

Na puto-pružnim prelazima najčešći uzrok po-
jave vanrednih događaja jeste sudar drumskog i 
železničkog vozila. Pri takvim situacijama oba- 
vezno je da upravljač železničke infrastrukture i 
prevoznik, bez odlaganja, telefonom prijave nes-
reću i nezgodu Centru za istraživanje nesreća 
u saobraćaju (CINS) i republičkom inspektoru 
za železnički saobraćaj. Prijava mora da sadrži 

sledeće podatke:
1.	 opis nesreće ili nezgode;
2.	 datum i vreme (čas i minut) nastanka nesreće 

ili nezgode;
3.	 mesto nesreće ili nezgode (naziv službenog 

mesta, kilometarski položaj otvorene pruge, 
objekat i sl.);

4.	 podatke o usmrćenima, povređenima i materi-
jalnoj šteti;

5.	 ako je nastalo ugrožavanje okoline, navesti ka-
kvo (curenje opasnih materija i sl.);

6.	 aktivirane mere za spasavanje, angažovanje 
službi hitne pomoći, policije itd.;

7.	 podatke o vozovima ili manevarskim sastavi-
ma;

8.	 opis infrastrukturnih podsistema na mestu 
nesreće ili nezgode;

9.	 vremenske uslove i geografske karakteristike 
terena;

10.	da li je nastalo zakrčenje susednih koloseka;
11.	preuzete mere radi zaštite i osiguranja mesta 

nesreće ili nezgode;
12.	podatke o železničkom osoblju i izvođačima 

radova koji su uključeni u nesreću ili nezgode i 
prisutnim svedocima;

13.	podatke o podnosiocu prijave;
14.	druge relevantne podatke.

Pored toga upravljač železničke infrastrukture i 
prevoznik dostavljaju pisanu prijavu Centru za 
istraživanje nesreća u saobraćaju i republičkom 
inspektoru za železnički saobraćaj elektronskim 
putem u roku od 24 sata od nastanka nesreće ili 
nezgode u železničkom saobraćaju. Pisana prijava, 
pored osnovnih (prethodno navedenih) podataka, 
mora da sadrži:
1.	 detaljan opis nesreće ili nezgode;
2.	 detaljne podatke o vozovima i njihovom sas-

tavu (brojeve vozova, relaciju saobraćaja, indi-
vidualne brojeve vučnih i vučenih vozila, tova-
reno/prazno, vrsta tovara);

3.	 detaljan opis infrastrukturnih podsistema na 
mestu nesreće ili nezgode;

4.	 broj usmrćenih i/ili povređenih lica, sa naz-
nakom da li su železničko osoblje, putnici, iz-
vođači radova ili treća lica;

5.	 podatke o materijalnoj šteti (na čemu je nasta-
la i, po mogućnosti, procena štete);
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Tabela 1. Deo prikaza evidencije putno-pružnih prelaza u Srbiji

6.	 podatke o prekidu saobraćaja, o zakašnjenju i 
otkazivanju vozova, da li je nastalo zakrčenje 
susednih koloseka;

7.	 upotrebljena sredstva za otklanjanje posledica 
i pružanje pomoći nastradalima;

8.	 podatke o ustanovama za pružanje medicinske 
pomoći, policiji i drugim organima i službama 
koji su izašli na mesto nesreće ili nezgode;

9.	 detaljan opis preduzetih mera za osiguranje 
mesta nesreće ili nezgode;

10.	sve druge relevantne podatke kojima se raspo-
laže u vezi sa  nesrećom ili nezgodom.

Ovi podaci su od izuzetnog značaja za obradu i do-
kumentovanje događaja u slučaju nesreća ili nez-
goda u železničkom saobraćaju [2].

3. OBRADA BAZE PODATAKA O
SAOBRAĆAJNIM NESREĆAMA 

3.1. Tabela PPP na prugama u Srbiji

Excel tabela svih putno-pružnih prelaza (tabela 1) 
na mreži pruga u Republici Srbiji sadrži sledeće  
podatke: šifru pruge, broj pruge na kojoj se posma-
trani putno-pružni prelaz nalazi, naziv pruge, ZOP 
kome pripada, kolosečnost pruge, broj koloseka 
na putno-pružnom prelazu, širinu putno-pružnog 
prelaza, površinu putno-pružnog prelaza, kilome-
tarski položaj, ime nadležne stanice za odgovara-
jući putno-pružni prelaz, način osiguranja kao i 
ostale relevantne podatke, imala je ključnu ulogu 
u izradi ovog rada.

3.2. Tabele evidentiranih nesreća i nezgoda

Eksel tabele o evidentiranim nesrećama i nez-
godama (tabele 2. i 3.) koriste se  kao  glavni  izvor 

podataka, a od podataka poseduju datum, vreme, 
mesto nesreće, broj pruge, vrstu i uzrok nesreće, kao 
i kratak opis vanrednog događaja, broj usmrćenih i 
povređenih lica, kao i podatke o troškovima koji su 

Primena QGIS softvera za obradu podataka o putno-pružnim prelazima
Re

d.
 b

r. 
P.

P.
P.

Ši
fr

a 
pr

ug
e

Br
oj

 p
ru

ge
K

la
sa

 p
ru

ge

Naziv pruge ZOP

Ko
lo

se
čn

os
t

Br
oj

 k
ol

os
ek

a 
na

 P
.P

.
Si

ri
na

 P
.P

.P
. (

m
)

Po
vr

ši
na

 P
. P

.P
. (

m
2)

K
m

 p
ol

oz
aj

 n
a 

os
ov

in
i 

pu
ta

N
ad

le
žn

a 
st

an
ic

a

N
ač

in
 o

si
gu

ra
nj

a
Vr

st
a 

ko
lo

vo
za

U
ga

o 
uk

rš
ta

nj
a 

pr
ug

e 
i 

pu
ta

 (s
te

pe
ni

)
Tr

ou
ga

o 
vi

dl
jiv

os
ti

K
at

eg
or

ija
 p

ut
a

Po
se

dn
ut

os
t P

.P
.P

.

N
os

ila
c 

pr
av

a 
ko

ri
sc

en
ja

1 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 6.0 36.0 0+431.00 Resnik 3 4 90 da ulica ne 1
2 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 3.0 18.0 8+012.00 B. Reka 1 4 90 da poljski ne 1
3 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 3.0 18.0 19+315.00 V. Borak 1 2 90 da poljski ne 1
4 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 9.0 54.0 20+497.00 V. Borak 3 2 60 da lokalni ne 1
5 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 3.0 18.0 21+942.00 V. Borak 1 4 90 da poljski ne 1
6 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 6.0 36.0 24+269.00 V. Borak 3 4 90 da lokalni ne 1
7 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 3.0 18.0 25+321.00 V. Borak 1 4 90 da poljski ne 1
8 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 4,5 30.0 27+708.00 Stepojevac 1 4 90 da poljski ne 1
9 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 3.0 18.0 28+547.00 Stepojevac 1 2 90 da poljski ne 1

10 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 4.0 24.0 29+952.00 Stepojevac 1 2 90 da poljski ne 1
11 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 4,5 27.0 31+198.00 Stepojevac 1 2 90 da poljski ne 1
13 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 4,5 30.0 33+484.00 Stepojevac 3 2 90 da lokalni ne 1
14 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 6.0 36.0 35+250.00 Vreoci 3 2 90 da lokalni ne 1
15 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 6.0 36.0 38+516.00 Vreoci 3 5, 2 90 da lokalni ne 1
16 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 6.0 36.0 42+656.00 Lazarevac 3 5, 2 60 da lokalni ne 1
17 108 1 MG Bgd.-Resnik-Podgorica-Bar Valjevo J 1 6.0 36.0 46+822.00 Lazarevac 1 5, 2 90 da lokalni ne 1
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Tabela 2. Deo prikaza evidentiranih Saobraćajnih nesreća u Srbiji

nastali pri nesrećama i nezgodama [3].

Pri izradi rada akcent je stavljen na korišćenje obe 
baze podataka, ali je preciznije proučavanje us-
mereno na analizu nesreća i incidenata koji su se 
desili na PPP. Primenom metoda i tehnika u QGIS 
softveru izvršena je detaljna obrada tih podataka 
o pojedinim relevantnim događajima, sa fokusom 

na identifikaciju i analizu specifičnih slučajeva 
nesreća koje su se odigravale na prelazima u oda-            
branom periodu od pet godina. Ova analiza je omo-
gućila dublje razumevanje dinamike i uzroke inci-
denata na prelazima, što je od suštinskog značaja 
za dalje unapređenje bezbednosti i efikasnosti up-
ravljanja saobraćajem na železničkim presečnim 
tačkama.

Datum Vreme Mesto

Vr
st

a
U

zr
ok Kratak opis

Usmrćeno Povređeno

Pr
eg

až
en

o 
vo

zi
la

Pr
ek

id
 s

ao
br

ać
aj

a 
(h

)

Šteta         
(RSD)
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tn

ik
a

Že
le
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ič

ar
a

Tr
eć

ih
 li

ca
Pu

tn
ik

a
Že

le
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ič
ar

a

Tr
eć

ih
 li

ca

1/1/2018 13:05 Požega 3 36
Pri manevri isklizla kola br. 31724775006-8 na 

skretnici br. 33                 121,448.00

1/4/2018 3:30 Ruma 16 58
Na PP u km 62+008 pad drumskog vozila na prugu, 

prekid saobraćaja               2 188,137.00

1/4/2018 8:14 Palanka 16 48 Nestanak napona, izgoreo naponski trafo               1  

1/5/2018 6:35 Senta 16 31
U km 60+870 i 60+500 polomljena šina i na više 

mesta otkinuta glava šine               28  

1/5/2018 15:45 Beograd 3 36
Pri manevri isklizla lok 621-301 između skretnica br. 

22 i 23                  

1/5/2018 23:00 Beograd 16 13
Na 2. koloseku došlo do samopokretanja kola br. 

50722076008-0                  

1/6/2018 2:25 Brvenik 16 27
Pucanje man. sastava kod kola br. 8072-3924214-0 i 

317239 24109-2                 456,311.00

1/6/2018 10:08 Lapovo 5 58
U km 107+000 usmrćeno treće lice od strane voza br. 

6731     1         2  

1/6/2018 17:35 Požarevac 6 60
Požar na gariranim kolima na 4. koloseku izazvan od 

strane trećih lica                 12,022,605.00

Datum Vreme Službeno mesto Kilometarski položaj i kratak opis Pruga Šteta (RSD) Odgovornost

3-Jan 19:26 Ruma U km 62+008 nalet drumskog vozila na postavnu spravu PP 101 153,189.00 Vozač drumskog vozila

5-Feb 19:03 U km 62+008, na PP PBK 2, pad drumskog vozila na prugu 101 77,473.80 Vozač drumskog vozila

29-Aug 6:44 U km 3+285 nalet voza br. 5223 na drumsko vozilo 211 123,000.00 Vozač drumskog vozila

27-Nov 22:00 U km 62+008, na PP PBK 2, pad drumskog vozila na prugu 101 10,933.00 Vozač drumskog vozila

27-Dec 3:50 U km 62+008, na PP PBK 2, pad drumskog vozila na prugu 101 Ѕ-79

31-Dec 3:50 U km 62+008, na PP PBK 2, pad drumskog vozila na prugu 101 Ѕ-79

9-Jan 12:39 Pančevo Varoš Na PP u km 0+907 nalet voza br. 7009 na drumsko vozilo 309 0 Vozač drumskog vozila

11-Feb 8:36 Na PP u km 17+544  nalet voza br. 7005 na drumsko vozilo 107 0 Vozač drumskog vozila

17-Jan 14:05 Kula Na PP u km 46+200 nalet voza br. 6422 na drumsko vozilo 307 260,075.30 Vozač drumskog vozila

16-Jul 19:40 Na PP u km 39+000 nalet voza br. 4627 na drumsko vozilo 307 49,000.00 Vozač drumskog vozila

Tabela 3. Deo prikaza obrađenih podataka službenih mesta sa najvećim brojem nesreća na putno-pruž-
nim prelazima u periodu od 2016-2020.
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Tabela 4. Prikaz broja saobraćajnih nesreća na 
putno-pružnim prelazima odgovarajućih pruga

Slika 3. Službeno mesto sa najvećim brojem 
nesreća u periodu od 2016. do  2020. godine 

(Loznica) [6]

Slika 4. Prikaz naseljenih mesta na području cele 
planete u QGIS softveru

Uz pomoć ovako sortiranih podataka veoma je 
lako da se utvrdi najopterećenija pruga na pod-
ručju celokupne železničke infrastrukture, kao i 
opterećenje svih ostalih pruga ako se upoređuju 
sve pruge na železničkoj mreži jedne sa drugom 
(slika 3). 

4. QGIS

4.1. Uvod u QGIS

QGIS, poznat i kao Quantum GIS,  geografski je 
informacioni sistem (GIS) otvorenog koda (sto-
ga i besplatan), koji omogućava korisnicima da 
kreiraju, uređuju, vizualizuju, analiziraju i objav- 
ljuju prostorne informacije. QGIS podržava širok 
spektar vektorskih, raster i baznih formata poda-
taka, uključujući format baze podataka PostGIS. 
Kao projekat otvorenog koda, QGIS je razvijala 
i održavala  globalna zajednica programera i ko-
risnika [4].

QGIS se koristi za različite svrhe, od osnovne kar-
tografije do složenih prostorno-analitičkih zada-
taka. Njegova fleksibilnost i proširivanje ga čine 
pogodnim za širok spektar korisnika, uključujući 
istraživače, planere, inženjere, obrazovne insti-
tucije, vladine agencije i neprofitne organizacije.

4.2. Osnovne Funkcije QGIS-a

QGIS omogućava korisnicima da kreiraju i uređuju 
vektorske slojeve, podržavajući različite geometri-
je poput tačaka, linija i poligona (slika 4). Takođe, 
podržava direktno uređivanje podataka u bazama 
podataka poput PostGIS-a [4].

QGIS pruža veoma moćne alate za vizualizaciju po-
dataka. Korisnici mogu da prilagodde stilove slojeva, 
pritom da koriste različite simbole, boje, oznake i 
da kreiraju složene karte koje prikazuju različite 

Primena QGIS softvera za obradu podataka o putno-pružnim prelazima

Broj pruge Broj nesreća
101 29
102 40
103 6
105 9
106 14
107 9
108 14
109 10
110 5
111 1
202 6
207 10
208 1
211 33
213 8
216 4
218 9
219 11
223 8

Ukupno 227
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Slika 5. Vizuelni prikaz podataka na teritoriji 
Srbije u QGIS softveru

Slika 6. Vizuelni prikaz stanice Beograd Centar u 
QGIS softveru

Slika 7. Prozor sa plaginovima u QGIS softveru

Analiza. QGIS uključuje alate za prostornu analizu, 
uključujući geo procesiranje, analizu mreža, raster 
analizu i analizu statističkih podataka. Integracija 
sa GDAL/OGR bibliotekom dodatno proširuje mo-
gućnosti analize.

Proširenja i Plaginovi. Jedna od ključnih snaga 
QGIS-a je podrška za proširenja i plaginove (slika 7). 

Korisnici mogu instalirati dodatne module za 
specifične zadatke, kao što su analize vodnih 
tokova, prostorno modelovanje ili integracija 
sa drugim GIS platformama [4].

4.3. Istorijat QGIS-a

QGIS projekat je započeo 2002. godine   Gary 
Sherman, koji je želeo stvoriti besplatan GIS 
alat koji bi mogao raditi na više platformi. 
Prva verzija QGIS-a (v0.1)  objavljena je u julu 
2002. godine. Ova prva verzija je bila prilično 
osnovna, sa ograničenim funkcionalnostima, 
ali je postavila temelje za dalji razvoj [4].
Kroz godine, QGIS je prošao kroz značajan razvoj 
i evoluciju. Kako se zajednica korisnika i progra- 
mera širila, tako su se širile i funkcionalnosti 
QGIS-a. Neki od ključnih momenata u razvoju 
QGIS-a uključuju:
•	 2004. godina: QGIS postaje GIS aplikacija koja 

podržava više platformi, uključujući Windows, 
Linux i macOS.

•	 2006. godina: Dodavanje podrške za plaginove, 
što omogućava korisnicima i programerima da 
prošire funkcionalnost QGIS-a prema potrebama.

•	 2008. godina: Integracija sa GRASS GIS-om, što 
omogućava korisnicima pristup moćnim alati-
ma za prostornu analizu i modeliranje.

•	 2010. godina: Objavljena verzija 1.5 koja dono-
si značajna unapređenja u interfejsu i perfor-
mansama.

•	 2013. godina: Objavljena verzija 2.0, koja uvo-
di mnoge nove funkcionalnosti i poboljšanja u 
korisničkom interfejsu.

•	 2018. godina: Objavljena verzija 3.0, koja 
donosi mnoge tehnološke inovacije, uključu-
jući podršku za 3D vizualizacije i unapređeni 
alat za crtanje [4].

4.4. QGIS Danas

Danas, QGIS je jedan od najpopularnijih i najmoćni-
jih GIS alata na svetu, sa aktivnom i posvećenom 
zajednicom koja kontinuirano radi na njegovom 
unapređenju i razvoju. Ovaj softver se široko ko-
risti u raznim sektorima kao što su urbanizam, 
poljoprivreda, zaštita životne sredine, transport, 

aspekte prostornih podataka (slike 5. i 6).
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telekomunikacije, hidrologija, istraživanje prirod-
nih resursa, planiranje infrastrukture i dr.

QGIS se ističe svojom integracijom sa brojnim dru-
gim otvorenim GIS alatima i platformama, kao što 
su GRASS GIS, SAGA GIS i PostGIS, što omogućava 
korisnicima da iskoriste širok spektar funkcional-
nosti i resursa za analizu i obradu prostornih po-
dataka. Ova integracija čini QGIS veoma moćnim 
i fleksibilnim alatom, sposobnim da odgovori na 
različite potrebe i zahteve korisnika.

Jedna od najvećih prednosti QGIS-a je njegova 
pristupačnost. Kao besplatan softver otvorenog 
koda, QGIS omogućava svim korisnicima, bez ob-
zira na njihove finansijske mogućnosti, pristup na-
prednim GIS alatima i resursima. Ovaj pristupačan 
model omogućava široku upotrebu u akademskim 
institucijama, istraživačkim organizacijama, nevla-
dinim organizacijama i manjim preduzećima koja 
možda nemaju resurse za skupe komercijalne GIS 
softvere.

Pored toga, otvorenost i transparentnost QGIS-a 
omogućavaju korisnicima da prilagode i prošire 
softver prema svojim specifičnim potrebama. Ko-
risnici mogu razvijati sopstvene plagine i dodatke, 
što čini QGIS izuzetno fleksibilnim i prilagodljivim 
alatom za rad sa prostornim podacima. Zajednica 
korisnika i programera neprekidno doprinosi raz-
voju novih funkcionalnosti, popravci grešaka i po-
boljšanju performansi, što osigurava da QGIS os-
tane aktuelan i u skladu sa najnovijim tehnološkim 
trendovima i zahtevima.

Kroz razne obuke, radionice i onlajn resurse, QGIS 
zajednica promoviše edukaciju i obuku novih ko-
risnika, što dodatno podstiče širenje i upotrebu 
ovog softvera širom sveta. QGIS je danas više od 
softvera – to je platforma za inovacije, saradnju i 
razmenu znanja u oblasti geoinformatike  i pros-
tornog planiranja.

Zahvaljujući svim ovim karakteristikama i pred-
nostima, QGIS se pozicionirao kao ključni alat u 
savremenom upravljanju prostornim podacima i 
analizama jer omogućava korisnicima da efikas-
no i efektivno upravljaju svojim prostornim infor-
macijama i donose informisane odluke [4].

4.5. Mogućnosti primene QGIS sistema 

QGIS (Quantum GIS)  moćan je geografski infor-
macioni sistem otvorenog koda koji nudi širok 
spektar mogućnosti za rad sa prostornim podaci-
ma [5]. Ova aplikacija se često koristi u istraživa- 
njima, planiranju, upravljanju resursima i drugim 
oblastima koje zahtevaju analizu i vizualizaciju 
geografskih informacija. Pregled nekih ključnih 
mogućnosti i sposobnosti koje QGIS nudi:
•	 Geo prostorne analize. QGIS omogućava iz-

vođenje različitih geoprostornih  analiza kao 
što su upiti za prostorne podatke, analiza pros-
torne distribucije, analiza udaljenosti, analiza 
rute i mnoge druge. Ove analize pomažu u ra-
zumevanju prostornih relacija i obrazaca.

•	 Vizualizacija podataka. Možete kreirati di- 
namičke i interaktivne karte koristeći različite 
slojeve podataka. QGIS podržava različite vrste 
podataka kao što su vektorski, raster i tabelar-
ni podaci, omogućavajući vam da kombinujete 
različite izvore i vrste podataka u vašim mapa-
ma.

•	 Uređivanje podataka. QGIS omogućava 
uređivanje vektorskih podataka direktno u ap-
likaciji. Možete dodavati, izmenjivati i brisati 
geografske objekte, što je korisno za kreiranje i 
ažuriranje geografskih podataka.

•	 Podrška za različite formate podataka.
QGIS podržava veliki broj formata podataka, 
uključujući Shapefile, GeoPackage, PostGIS, 
kao i mnoge druge formate vektorskih, raster 
i tabelarnih podataka. Ovo čini QGIS veoma 
fleksibilnim za rad sa različitim izvorima po-
dataka.

•	 Prostorne baze podataka. QGIS ima podršku 
za povezivanje sa prostornim bazama poda-
taka kao što su PostgreSQL/PostGIS, SQLite, 
Oracle Spatial, što omogućava efikasno uprav- 
ljanje velikim količinama prostornih podataka.

•	 Alati za analizu i obradu podataka. QGIS 
dolazi sa širokim spektrom alata za analizu 
podataka kao što su alati za raster analizu, za 
interpolaciju, za površinsku analizu, za geo 
procesiranje i mnogi drugi, što omogućava na-
predne analize podataka direktno u aplikaciji.

•	 Ekstenzije i dodaci. QGIS ima veliku zajednicu 
koja razvija ekstenzije i dodatke koji dodaju do-
datne funkcionalnosti aplikaciji. Ovi dodaci mogu 
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Slika 8. Planiranje i optimizacija trase u QGIS 
softver-u

da obuhvate sve, od specijalizovanih alata za ana- 
lizu do dodatnih opcija za vizualizaciju i obradu 
podataka.

•	 Otvoreni kod i zajednica. Kao softver ot-
vorenog koda, QGIS je besplatan za korišće- nje 
i ima aktivnu zajednicu korisnika i razvojnih 
timova koji doprinose njegovom održavanju 
i  razvoju. Ovo osigurava kontinuirano pobo- 
ljšanje i podršku za korisnike širom sveta [9].

Ove mogućnosti čine QGIS svestranim alatom za 
sve korisnke koji rade sa prostornim podacima, 
bilo da su u pitanju naučno-istraživački projekti, 
planiranje, upravljanje resursima ili neke druge 
aplikacije koje zahtevaju upotrebu geografskih in-
formacionih sistema.

4.6. Mogućnosti primene QGIS sistema u 
železničkom saobraćaju

 
U železničkom saobraćaju, efikasno upravljanje i 
planiranje infrastrukture su ključni za osigurava- 
nje bezbednosti i ekonomske efikasnosti. Upravo u 
ovom kontekstu, Quantum GIS (QGIS) pokazao se 
kao moćan saveznik inženjera, planera i analitičara, 
omogućavajući im da detaljno analiziraju prostorne 
podatke i da donesu informisane odluke (slika 8).
Planiranje i optimizacija trase: QGIS omogućava 
detaljno modeliranje i analizu terena duž potenci-
jalnih železničkih trasa. Koristeći digitalne visinske 

modele (DEM) i alate za analizu terena, inženjeri 
mogu optimizovati trase kako bi minimizirali nagibe, 
smanjili troškove gradnje i smanjili uticaj na život-
nu sredinu. Ovo je od ključne važnosti pri planiranju 
novih pruga ili pri rekonstrukciji postojećih.

Analiza bezbednosti na prelazima: Bezbednost na 
putno-železničkim prelazima je jedan od najbitnijih 
aspekata železničke infrastrukture. QGIS omoguća-
va analizu saobraćajnih tokova, gustine naseljenosti i 
karakteristike prelaza kako bi se identifikovala rizič-
na mesta i predložila unapređenja koja bi povećala 
bezbednost korisnika i vozova.
 
Upravljanje imovinom i održavanje infrastruk-
ture: Efikasno upravljanje železničkom infrastruk-
turom zahteva praćenje lokacija imovine, planira- 
nje redovnog održavanja i brzu reakciju na potrebe 
održavanja. QGIS pruža alate za detaljno upravljanje 
imovinom, što omogućava efikasno planiranje resur-
sa i produženje radnog veka infrastrukture.

Optimizacija operacija i analiza kapaciteta: 
Ana- liza kapaciteta železničkih pruga je ključna 
za optimizaciju rasporeda vozova i efikasnost op-
eracija. QGIS omogućava analizu kapaciteta, što 
pomaže boljem razumevanju opterećenja mreže i 
identifikacija potencijalnih uskih grla ili problema 
sa kapacitetom.

Integracija sa drugim sistemima: QGIS se lako inte-
griše sa drugim sistemima za upravljanje železničkim 
saobraćajem, kao što su informacioni sistemi o redu 
vožnje ili sistemi za praćenje vozova. Ova integracija 
omogućava praćenje vozova u realnom vremenu, bo-
lju koordinaciju operacija i efikasniju razmenu infor-
macija između različitih operativnih jedinica.

QGIS se stoga pokazao kao neophodan alat za mo- 
dernizaciju i unapređenje železničkog saobraćaja 
(slika 9) jer omogućava stručnjacima da precizno 
modeliraju, analiziraju i optimizuju infrastrukturne 
projekte za stvaranje sigurnog, efikasnog i održivog 
železničkog sistema.

Slika 9. 3D prikaz železničke stanice u QGIS 
softveru
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Slika 10. Kreiranje novog projekta u QGIS softveru

Slika 11. Početni interfejs QGIS softvera i ključni 
elementi koji ga sačinjavaju

5. OBRADA PODATAKA KORIŠĆENJEM 
QGIS-A

5.1. Kreiranje novog projekta u QGIS-u 

Kreiranje novog projekta u QGIS-u predstavlja os-           
novu za svaki geografski informatički rad i is-
traživanje. Ovaj proces započinje pokretanjem QGIS 
aplikacije na računaru (slika 10). Po otvaranju pro-
grama automatski se kreira novi prazan projekat, 
spreman za dodavanje podataka i početak rada. 
Ukoliko želimo da započnemo novi projekat tokom 
rada, jednostavno biramo opciju Project > New ili 
kliknemo na ikonu New Project na alatnoj traci.

Da bi se izbegao gubitak podataka, QGIS nudi op-
ciju automatskog čuvanja projekta, koja se može 
aktivirati kroz Settings > Options > General, gde se 
čekira opcija Enable auto-save of project. Takođe, 
preporučuje se da svi podaci povezani sa projektom 
budu organizovani u jednom direktorijumu, čime 
se izbegavaju problemi sa putanjama do datoteka.

Kreiranje i čuvanje projekata u QGIS-u je proces 
koji zahteva veliku pažnju, ali pri tom pruža veoma 
moćne alate koji služe za obradu i analizu različitih 
geografskih podataka. Redovnim čuvanjem i do-
brom organizacijom podataka možemo osigurati 
da rad bude efikasan i da rezultati budu tačni i pou-
zdani.

5.2. Grafički korisnički interfejs QGIS-a

Početni interfejs QGIS-a je sastavljen od nekoliko 
ključnih elemenata, koji omogućavaju korisnici-
ma da efikasno rade sa geografskim podacima 
(slika 11). Glavne komponente početnog interfejsa 
QGIS-a su:

Meni Bar (Menu Bar): Ovaj deo se nalazi na vrhu 
interfejsa i sadrži osnovne menije kao što su File, 
Edit, View, Layer, Settings, Plugins, Vector, Ras-
ter, Database, Web, Processing i Help. Svaki meni 
sadrži različite opcije za upravljanje projektom, 
uređivanje slojeva, podešavanje interfejsa i druge 
funkcije.

Alatna Traka (Toolbars): Alatne trake su smeš-
tene ispod menija i sadrže ikone za brzi pristup 
često korišćenim alatima i opcijama. Postoji više 
alatnih traka, uključujući alatne trake za upravljanje 
projektom, navigaciju mapom, alatke za uređivanje 
i druge specifične funkcije.

Panel za Slojeve (Layers Panel): Ovaj panel se 
obično nalazi sa leve strane i prikazuje listu svih 
slojeva koji su dodati u projekat. Omogućava ko-
risnicima da uključuju/isključuju vidljivost sloje-
va, menjaju redosled slojeva i pristupaju opcijama 
za uređivanje slojeva.

Mapa (Map Canvas): Glavni deo interfejsa gde se 
prikazuju svi slojevi i podaci. Korisnici mogu da 
zumiraju, pomeraju i sprežu sa mapom u ovom 
prostoru. Mapa je centralno mesto za vizualizaciju 
geografskih podataka.

Statusna Traka (Status Bar): Smeštena na dnu 
interfejsa, statusna traka prikazuje informacije 
kao što su trenutne koordinate pokazivača miša, 
skala mape i status zadataka koji su u toku.

Panel Alatki (Processing Toolbox): Ovaj pan-
el sadrži širok spektar alata za prostorne analize 
i geoprocesiranje. Omogućava pristup alatima za 
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Slika 12. Kreiranje novog sloja (lejera) u QGIS 
softver-u

obradu vektorskih i rasterskih podataka, kao i do-
datnim funkcijama koje se mogu instalirati kroz 
plaginove.

Browser Panel: Panel koji omogućava pretragu i 
pregled podataka na lokalnom disku, kao i podataka 
sa udaljenih izvora. Ovo olakšava dodavanje novih 
slojeva u projekat.

Konzola (Python Console): Konzola (Python Console): Ovaj panel omoguća-
va korisnicima da pišu i izvršavaju Python skripte 
direktno u QGIS-u. Koristan je za automatizaciju 
zadataka i napredne analize.

Ovi elementi zajedno čine fleksibilan i moćan in-
terfejs QGIS-a, omogućavajući korisnicima da efi-
kasno rade sa svojim geografskim podacima [4].

5.3. Proces Kreiranja Sloja (lejera) i Mape 
u QGIS-u

Rad sa geografskim podacima u QGIS-u počinje krei-
ranjem novih slojeva i učitavanjem mapa iz različitih 
izvora. Ovi koraci su osnova za sve buduće analize i 
vizualizacije koje se mogu izvršiti u ovom alatu (slika 
12). Evo kako se to radi, korak po korak [4].

Kada pokrenemo QGIS, kreiranje novog vektor- 

želimo da koristimo, bilo da su to tačke, linije ili 
poligoni. Ovde takođe možemo dodati atribute 
koji će biti povezani sa ovim geometrijama, kao 
što su naziv, tip ili bilo koji drugi podatak koji je 
relevantan za naš projekat.

Nakon definisanja atributa i izbora lokacije za sni-
manje sloja, klikom na OK naš novi sloj će se po-
javiti u Layers panelu i biti spreman za uređivanje. 
Da bismo dodali podatke u ovaj sloj, aktiviramo 
alatku za uređivanje klikom na ikonicu olovke na 
alatnoj traci. Korišćenjem alatki za crtanje, može-
mo dodati nove geometrije u sloj i uneti atribute 
za svaki novi element.

Instaliranje OSM plagina predstavlja sledeći kor-
ak ako ranije nije instaliran (slika 13). Ova in-
stalacije postiže se izborom komande Plugins > 
Manage and Install Plugins... i pretraživanjem op-
cije OpenStreetMap ili QuickMapServices. Nakon 
instalacije, možemo dodati OSM mapu izborom 
komande Web > QuickMapServices > OSM > OSM 
Standard iz menija.

skog sloja je prvi korak, to se postiže izborom op-
cije Layer > Create Layer > New Shapefile Layer... 
ili New Geopackage Layer... iz glavnog menija. U 
dijalogu koji se otvori, biramo tip geometrije koju 

Slika 13. Instaliranje OSM plagina u QGIS softveru

Ako želimo ručno da dodamo OSM mapu, možemo 
koristiti WMS ili XYZ Tile. Za ovaj proces idemo 
na Layer > Add Layer > Add WMS/WMTS Layer... 
ili Add XYZ Layer... i unosimo URL: https://tile.
openstreetmap.org/{z}/{x}/{y}.png, koji naziva-
mo “OSM”. Klikom na OK, ovaj sloj se pojav- ljuje u 
Layers panelu.
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Slika 14. Prikaz mape Srbije putem OSM-a u QGIS 
softver-u

Slika 15. Dodavanje pruga u QGIS softveru

Dodavanje drugih izvora mapa je takođe moguće ko-
rišćenjem istih koraka kao i za OSM, ali sa različitim 
URL-ovima za druge WMS/WMTS ili XYZ Tile usluge. 
Na primer, mnogi provajderi, kao što su Google i Bing, 
nude javne mape koje mogu biti dodate na ovaj način.

Učitavanje mape u QGIS kroz OpenStreetMap (OSM) 
pruža korisnicima mogućnost da brzo pri-stupe 
globalnim geografskim podacima. Ovaj proces je jed-
nostavan i omogućava korisnicima različitih nivoa 
iskustva da efikasno rade sa prostornim podacima. 

Mapa se ubacuje tako što nakon instalacije plagina, 
QGIS aplikacija otvara mogućnost za dodavanje OSM 
Mape preko QuickMapServices. U meni baru nalazi se 
opcija Web, gde izabirom QuickMapServices > OSM > 
OSM Standard dodajemo željene podatke. U QGIS-u 
će se automatski učitati OSM mapa u interaktivnom 
okruženju (slika 14). Kada se OSM mapa pojavi u 
QGIS-u, mapu je moguće prilagoditi svojim potre-
bama, uključujući zumiranje na određene oblasti, 
promenu stilova prikaza ili dodavanje dodatnih slo-
jeva. Za istraživanje i prilagođavanje mape, mogu se 
koristiti alatke za navigaciju i uređivanje u QGIS-u.

5.4. Proces kreiranja sloja i dodavanja 
pruga i putno-pružnih prelaza u QGIS-u 

Prikupljanje podataka o prugama i putno-pružnim 
prelazima predstavljalo je ključni korak u ovom 
istraživanju. Koristeći podatke iz OpenStreetMap 
(OSM) baze, obezbeđene su geografske koordi-
nate i atributne informacije koje omogućavaju de-
taljnu analizu i vizualizaciju. Ovi podaci su zatim 
integrisani u QGIS, što omogućava sveobuhvatno 
istraživanje prostornih odnosa na teritoriji Srbije. 
Iako je OSM veoma koristan plagin, pri dodavanju 
PPP pokazao se još uvek nedovoljno unapređenim 
i  zato su korišćene druge metode dodavanja vek-
torskih informacija u QGIS [8].

Nakon dodavanja sloja mape Srbije, prethodno 
preuzete sa OSM-a, dodavanjem vektorskih slo-
jeva za pruge i putno-pružne prelaze, započet je 
proces vizualizacije i analize prostornih odnosa na 
teritoriji Srbije u QGIS-u.

Dodavanje sloja za pruge: Dodavanje sloja za 
pruge počinje  izborom opcije Layer iz glavnog 
menija QGIS-a, zatim Add Layer, i na kraju Add 
Vector Layer (slika 15). Nakon toga, u dijalogu 
za dodavanje slojeva, izabrana je opcija Browse, 
kojom su pretraženi lokalni fajlovi kako bi se 
pronašao odgovarajući vektorski fajl sa podacima 
o prugama. Ovi podaci su bili preuzeti u formatu 
Shapefile (.shp) iz OSM baze. Klikom na Add, sloj 
pruga je dodat na mapu i odmah postao vidljiv u 
Layers panelu.

Dodavanje sloja za putno-pružne prelaze: 
Sličan postupak primenjen je za dodavanje sloja 
putno-pružnih prelaza (slika 16). Pri tom pono-
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Slika 16. Dodavanje putno-pružnih prelaza OSM 
plaginom u QGIS softveru

Slika 17. Kod Query-a za dodavanje tačke 
putno-pružnog prelaza korišćenjem koordinata

Pri dodavanju puto-pružnih prelaza nailazimo na 
loše unesene podatke u samom OSM-u, na pri-
kazanoj slici vidimo da su podaci o PPP uneseni 
samo za područje Beograda, tako da unošenje put-
no-pružnih prelaza obavljamo drugom metodom.

5.5. Proces unosa geografskih tačaka 
putem koordinata i putem koda u QGIS

Korišćenje QGIS-a za unos tačaka pomoću koordi-
nata omogućava korisnicima da detaljno mapiraju 
prostorne podatke u skladu sa njihovim potrebama i 
zahtevima projekta. Ovaj proces je ključan u geograf-
skom informacionom sistemu za precizno lociranje, 
kao i detaljnu analizu prostornih podataka.

Ovaj proces unošenja obavlja se tako što se prven-
stveno pronađu i defini[u odgovarajuće koordinate 
tačke koju treba da se unese, u ovom slučaju to su 
koordinate putno-pružnog prelaza, što je moguće 
uraditi primenom Google Map-a. Zatim se piše 
kratak kod (slika 17) koji omogućava projektan-
tu da napravi odgovarajući Query koji treba da se 
implementira u rad (projekat). Kod za dodavanje 
pointa (tačke) putem koordinate glasi:

Nakon kreiranja prethodnog koda (slika 18) ve-
oma je važno da se kod sačuva u odgovarajućem 
formatu, odnosno da se sačuva sa odgovarajućom 
ekstenzijom za naziv datoteke tipa “gojson”, koja 
projektantu omogućava da se novonastala datote-
ka pozove u funkciju tako što što će projektant da 
doda jedan novi sloj (lejer) pritiskom na opciju 
Layer > Add Layer > Add Vector Layer.... 

vo se koristi opcija Add Vector Layer... iz menija 
Layer, a zatim treba de se izabere opcija Browse 
za pronalaženje vektorskog fajla sa odgovarajućim 
podacima o prelazima. Ovi podaci su takođe bili 
preuzeti iz OSM baze i sačuvani u formatu Geo-
JSON (.geojson). Klikom na Add, sloj prelaza je do-
dat na mapu i pojavio se u Layers panelu.

Slika 18. Kreiranje fajla u kojem se nalazi Query

Izborom odgovarajuće point.gojson datoteke, 
QGIS će je automatski da učita sve odgovarajuće 
podatke o putno-pružnom prelazu.

Nakon unošenja odgovarajućeg Query-a u QGIS-u 
se pojavljuje novi lejer sa unesenom funkcijom 
koju projektant zadao. U studiji slučaja urađenoj 
u ovom radu prezentovan je putno-pružni prelaz 
u Loznici koji se nalazi u km 49+511 pruge 211 
(slika 19).
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Slika 21. Grafički prikaz svih putno-pružnih 
prelaza u nivou u QGIS softveru

Slika 19. Prikaz putno-pružnog prelaza primenom 
kreiranog Query-a u QGIS softveru

Slika 20. Kod Query-a koji prikazuje sve 
putno-pružne prelaze u nivou

Ovim načinom unošenja puto-pružnih prelaza 
dobijamo precizne i jasno vidljive podatke o put-
no-pružnom prelazu na teritoriji Srbije, ali nailaz-
imo na problem same efikasnosti primene krei-
ranja većeg broja putnih prelaza. Shodno tome 
kreiramo novi kod i novi Query koji će nam omo-
gućiti da mapiramo sve putno-pružne prelaze u 
nivou na teritoriji cele Srbije (slika 20).
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Slika 22. Grafički prikaz stanica u Srbiji u QGIS softveru

Kreiranjem ovog Query-a i njegovom implmentaci-
jom dobijamo pozicije svih putno-pružnih prelaza 
u nivou na mreži pruga na teritoriji cele Srbije 
(slika 21).

Korišćenje ove metode u QGIS-u je jedan od načina
za efikasno upravljanje i manipulaciju podacima, 
posebno kada se radi sa velikim količinama geo-
prostornih informacija ili kada želimo izvršiti 
specifične operacije koje nisu direktno podržane 
standardnim alatkama za obradu podataka u 
QGIS-u. Pored putno-pružnih prelaza moguće je 
dodati i ostale podatke kao što su položaji stanica,
presek svih drumskih i železničkih puteva i mnoge
duge (slike 22. i 23).
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Slika 23. Grafički prikaz svih tačaka preseka drum-
ske i železničke infrastrukture u QGIS softveru

Slika 24. Kartica koja se koristi za uređivanje 
izgleda pruga QGIS softvera

Slika 25. Kartica za uređivanje izgleda 
putno-pružnih prelaza QGIS softvera

Za prilagođavanje stilova sloja pruge, desnim kli-
kom na sloj u Layers panelu izabrana bira seopci-
ja Properties, a zatim kartica Symbology. Ovde je 
podešen stil pruge, uključujući boju (crna) i de-
bljinu linije (1,6 mm), kako bi pruge bile jasno vidl-
jive na mapi [4].

Za sloj putno-pružnih prelaza, takođe je otvore-
na kartica Symbology iz prozora Layer Properties. 
Prelazi su prikazani kao tačke sa narandžastim kru-
govima, što omogućava lako razlikovanje prelaza od 
ostalih objekata na mapi (slika 25).

5.6. Vizualizacija podataka

Nakon uspešnog dodavanja slojeva, pristupilo se 
njihovoj vizualizaciji. Prvi korak bio je prilagođa-
vanje stilova slojeva kako bi se obezbedila jasna i 
pregledna prezentacija podataka (slika 24).

5.7. Analiza podataka

Sa dodatim i vizuelno prilagođenim slojevima, 
naredni korak bio je sprovođenje prostorne ana-
lize. Prva analiza fokusirala se na identifikaciju 
gustine putno-pružnih prelaza. Korišćenjem Heat-
map alata generisana je toplotna mapa koja prika-
zuje koncentraciju prelaza, što je omogućilo iden-
tifikaciju područja sa najgušćom mrežom prelaza 
(slika 26). Na osnovu te analize dobijamo podatak 
na osnovu kojeg možemo prikazati sve opštine u 
Srbiji koje poseduju putno-pružne prelaze, kao i 
prugu koja poseduje najveći broj PPP (slika 27).

Rezultati primene prikaza toplotne mape prika-
zani su kroz boje i intenzitete na mapi i jasno su 
označena područja sa najvećom gustinom PPP. 
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Slika 28. Grafički prikaz pruge 102 i opština kroz 
koje prolazi pruga u QGIS softveru

Slika 26. Grafički prikaz najveće kocentracije PPP na 
prugama Srbije, u QGIS softveru (pruga 102)

Slika 27. Grafički prikaz opština koje poseduju 
putno-pružni prelaz u QGIS softveru
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Analizom toplotne mape zaključujemo da je pruga 
Beograd – Niš – Preševo  (oznaka 102) pruga sa na-
jvećim brojem PPP u Srbiji (slika 28). Ovaj podatak 
je potvrđen podacima koje je pružila vizualizacija 
podataka, kao i sama činjenica da smo taj podatak za 
prugu 102 obradili u gore navedenim excel tabelama.

Korišćenje heatmap-e u QGIS-u se pokazalo kao efi-
kasan metod za istraživanje i interpretaciju pros-
tornih podataka, pružajući dublji uvid u raspodelu i 
zastupljenost PPP na prugama. Ovaj rad je naglasio 
značaj analitičkih alata i vizuelnih tehnika u razume-
vanju prostornih obrazaca i donošenju informisanih 
zaključaka na osnovu  geoprostornih podataka [10].

5.8. Mogućnost prikaza podataka putem 
HTML map tips -a u QGIS-u

U QGIS-u, jedan od načina za interaktivno prikazivan-
je podataka na karti je kroz korišćenje HTML map 
tips-a. Ova funkcionalnost omogućava korisnicima da 
prilikom pomeranja miša preko tačke na karti dobi-
ju dodatne informacije ili vizuelne sadržaje u obliku 
HTML formatiranih prozora [9].
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Slika 29. Proces unošenja podataka primenom 
HTML-a u QGIS softveru

Slika 30. Vizuelni prikaz podataka o saobraćajnoj 
nesreći na putno-pružnom prelazu u km 53+451 

pruge 101

Slika 31. Vizuelni prikaz podataka o vanrednim 
događajima na putno-pružnom prelazu u km 

49+004 pruge 211

Prikazivanje preko HTML map tips-a olakšava ra-
zumevanje prostornih podataka na više načina:
1.	 Omogućava detaljnije informacije o karakter-

ističnim tačkama na karti. Na primer, korisnici 
mogu da vide atributne informacije kao što su 
naziv, opis ili numeričke vrednosti, što može 
biti ključno za analizu ili istraživanje (slika 30).

2.	 HTML map tips može da uključi i  grafičke e- 
lemente kao što su slike, dijagrami ili čak in-
teraktivni grafici, čime se dodatno poboljšava 
vizualizacija podataka (slika 31).

3.	 Ova funkcionalnost je posebno korisna za pre- 
zentacije ili deljenje prostornih podataka sa 
drugima jer omogućava intuitivan pristup de-
taljnim informacijama bez potrebe za ulaskom 
u kompleksne tabele ili grafikone (slika 32).

Proces unošenja podataka u HTML map tips se ost-
varuje tako što kliknemo desnim klikom na odgo-
varajući lejer u panelu Layers (Slojevi) i izaberemo 
Properties (Svojstva), zatim u prozoru svojstava, 
pritiskom na karticu Display (Prikaz) otvaramo pro-
zor u koji unosimo željene podatke u vidu teksta, slike 
itd. HTML map tips poseduje posebnu gramatiku un-
ošenja podataka koja je prikazana na slici 29.

Slika 32. Vizuelni prikaz podataka o saobraćajnim 
nesrećama na putno-pružnom prelazu u km 49+511 

pruge 211

QGIS pruža mogućnost prilagođavanja HTML map 
tips-a putem HTML i CSS kodiranja, što korisnici-
ma omogućava da prilagode izgled i sadržaj pre-
ma svojim potrebama ili korporativnom identitetu 
(slike 33, 34. i 35).
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Slika 33. Vizuelni prikaz podataka o saobraćajnim 
nesrećama na putno-pružnom prelazu u km 

57+306 pruge 207

Slika 34. Vizuelni prikaz podataka o saobraćajnim 
nesrećama na putno-pružnom prelazu u km 

134+890 pruge 102

Slika 35. Vizuelni prikaz podataka o saobraćajnim 
nesrećama  na putno-pružnom prelazu u km 

17+352 pruge 106

6. ZAKLJUČAK

Geografskim informacionim sistemom QGIS pred-
stavljen je značaj primene softvera u analizi put-
no-pružnih prelaza u Srbiji. Kroz detaljnu obradu 
i vizualizaciju podataka, identifikovane su ključne 
tačke interakcije između železničkog i drumskog 
saobraćaja, kao i oblasti sa najvećim rizikom od 
nesreća. Implementacija QGIS-a omogućila je ne 
samo efikasno mapiranje i analizu postojećih put-
no-pružnih prelaza, već i identifikaciju i potenci-
jalne predloge mera za unapređenje sigurnosti na 
ovim kritičnim tačkama.

Jedan od zaključaka ovog istraživanja je da su naj- 
češći uzroci nesreća na putno-pružnim prelazima 
nepoštovanje saobraćajnih propisa od strane vozača 
i nepovoljni tehnički uslovi infrastrukture. QGIS je 
omogućio da se ovi problemi vizualizuju i analizira-
ju na sistematičan način, što je olakšalo identifikaciju 
kritičnih tačaka i planiranje potrebnih intervencija.

Dalji razvoj i unapređenje QGIS softvera mogli 
bi dodatno da povećaju njegovu upotrebljivost, 
efikasnost i pouzdanostu ovakvim analizama. In-
tegracija sa drugim bazama podataka i alatima 
za analizu saobraćajnih nesreća može pružiti još 
bolje i detaljnijih uvida u stanje bezbednosti sao-
braćaja i da na taj način pomognu u formiranju sve-
obuhvatnijih strategija za unapređenje sigurnosti i 
bezbednosti na putno-pružnim prelazima. Takođe, 
razvoj dodatnih funkcionalnih alata za simulaciju i 
predikciju saobraćajnih tokova može značajno da 
doprinese prevenciji nesreća i planiranju razvoja i 
unapređenja saobraćajne infrastrukture.

Važnost korišćenja naprednih GIS alata u analizi 
saobraćajne infrastrukture, a naročito pruga pred-
stavlja značajan faktor u istraživanju, planiranju i 
projektovanju na železnici [11]. Samim razvojem 
novih tehnologija, kao i njihovom praktičnom 
primenom dolazi do potencijalnih unapređenja 
i iznalaženja novih načina za povećanje bezbed-
nosti i značajno smanjenje rizika od nesreća na 
putno-pružnim prelazima. QGIS se pokazao kao 
veoma moćan alat koji predstavlja podršku dono-
siocima odluka u funkciji poboljšanja efikasnosti 
i bezbednosti saobraćaja. na taj način direktnose  
poboljšava ukupna saobraćajna infrastruktura, 
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a istovremeno smanjuju rizici od dešavanja sao-
braćajnih nesreća na putno-pružnim prelazima, 
ali isto tako i ukupno.
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